TigerTrak TM-1 & TM-1+ Tracking Modules
Grants Pass, Oregon

154 Hillview Drive Grants Pass, Oregon 97527

-

- INTRODUCTION The TigerTrak TM-1 and TM-1+ are highly sophisticated,
fully programmable, tracking and telemetry modules. These
units have been designed to meet the most stringent
requirements of both the commercial and amateur user. The
TM-1 employs the latest in high density "surface mount"
technology, assuring high reliability and compact size.
The standard TM-1 Tracker features a single "Tracking"
mode that can be configured for APRS® compatibility. The
TM-1+ "MultiMode" Tracker supports the basic tracking
mode of the TM-1, plus several additional modes for
specialized tracking and telemetry applications. Additionally,
the TM-1+ includes solid-state power switching for an
external device like a GPS. This allows OEM GPS receivers
like the Garmin GPS-35 to have their power controlled
directly by the TigerTrak. Both TM-1 models employ the
latest in "Flash" microcontroller technology, allowing
additional features and functions to be added without adding
additional hardware. Flash technology also allows the TM-1
to be upgraded to a TM-1+ in the event your tracking
requirements change! Both models come completely
assembled and tested and include an easy to use Windows
configuration program.
The TM-1 and TM-1+ are easily interfaced to most base,
mobile, and hand-held radios. Since power consumption is
extremely low, the units can usually be powered directly
from the "Aux Power” pin on the radios mic connector. For
APRS® and some other tracking applications, the TM-1 is
connected in parallel with the microphone. This allows you
to use the radio for voice communications and tracking
simultaneously. It also allows the mic PTT to trigger the
tracker at the end of each voice transmission (mic encoding).
Special circuitry in the TigerTrak allows it to "mute" the
radios mic and control PTT operation without the need to
break any of the mic lines!
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COMMERCIAL APPLICATIONS –

Our most fundamental goal in the design of this unit was to
create a flexible and fully programmable platform on which
a wide variety of other devices could be built. The
TigerTrak is just the first of many products that will be built
on this technology. The basic design of this unit makes it
extremely easy and inexpensive to adapt to a custom
application. The use of multiple Flash based processors
allows us to inventory finished boards which can be
programmed to become a variety of products on a moments
notice. Every aspect of this devices production takes place
within our own facility. We fabricate the extruded case,
injection mold the covers, NC mill the openings, make
artwork, silkscreens, tooling and even do the robotic
assembly under one roof! All of this makes it very easy and
economical for us to adapt the unit to your special needs.
We are a full service quick turn solution. If you have an
application that we might be able to adapt this unit to, we
invite you to discuss it with our engineering staff.
- ABOUT THIS MANUAL –
Because the TigerTrak’s setup varies widely with each of its
operating modes, this manual will focus mainly on issues
common to all modes. This includes general information on
installation, operation, and specifications, as well as an
overview of the TigerTraks main operating modes. Detailed
information for setup of specific modes will be covered by
the on-line HELP files included with the Configuration
Program. Having these details in the Configuration Program
allows the information to be regularly updated by
downloading new help files from our web site. You can
obtain HELP at any time when you are using the program by
placing the cursor in the field of interest and pressing F1.
Access to the entire HELP database is available from the
Help Menu at the top of the screen.
- WHAT YOU WILL NEED In order to program the various functions of the TigerTrak
you will need to connect it to an IBM compatible computer
running Windows 95 or Windows 98 and the Configuration
Program that we have supplied. Note that our program will
not operate with earlier versions of Windows or from
MSDOS. Your computer must have a free serial port in the
range of COM1 to COM4. To connect the TM-1 to your
computer, you will need a standard serial interface cable.
Figure-1 shows the wiring of the cable. Note that only four
of the nine lines are required.

Computer
DB-9F (DB-25F)

supplied through either the “Ext Pwr” connector, or through
Pin ”B” (black wire) on the radio interface connector (RJ11). Power from these two sources is handled differently
inside the TM-1, so the connection you select will depend on
your application. A description of each power option
follows. Figure-2 will help you understand the TM-1’s
power routing circuitry.

TM-1
Receive DB-9M

Receive Data 2 (3)

2 Transmit Data

Transmit Data 3 (2)

3 Receive Data

Request To Send 7 (4)

7 Request To Send

Ground 5 (7)

5 Ground

Figure-1 TM-1 to computer interface cable

The TigerTrak is supplied with a radio cable that has the
connector already installed on the TM-1 end. You will need
to provide whatever connectors are necessary to attach the
other end to your particular radio. If you are wiring the TM1 to a dedicated radio (no microphone), you will simply need
to attach the appropriate connectors to the end of the cable.
If you are using the TM-1 as a APRS® tracker and you also
want to use the radio for voice communications, then you
will need to attach the TM-1 lines in parallel with the
existing microphone lines. Tigertronics offers an optional
Mic Adapter Kit that will greatly simplify this process.
Refer to the section on “Connecting Mobile & Data Radios”
for additional details.

Figure-2 Power Input Circuit
WARNING: Incorrect power wiring can destroy the TM-1
and the equipment that it is connected to. ALWAYS use a
fuse in the power line. Be sure to read this entire section
before applying power!

- INSTALLING THE SOFTWARE –
Before you can use the TM-1 you will need to program it
using the Configuration Program that we have provided.
This program may have been supplied on either floppy disks
or CDROM, but the installation procedure is the same for
both. The software must be installed on a computer running
either Windows 95 or 98. Before installing the program you
should review the README file on the installation disk.
This file contains important information that you should be
aware of before installing the main program.

External Power Connector – External power can be
applied to the TM-1 through a 2.1mm coaxial power
connector on the rear panel. This power input is reversevoltage and over-current protected. A PTC self-resetting
fuse limits the input current to a maximum of 300ma. The
high current rating of the fuse was chosen so that this input
could also be used to power a GPS or other telemetry device
through Pin #9 of the DB-9 connector on the Data/Control
port. See “Powering A GPS Receiver” for more information.

To install the Configuration Program follow these steps:

Radio Interface Connector - Pin “B” (black wire) on the
RJ-11 radio connector provides another means of supplying
power to the TM-1. Extreme caution must be used when
connecting power to this input, as it is NOT reverse-voltage
or over-current protected. Before powering the TigerTrak
from the mic connector, you must check the radios
documentation to be sure that it is safe to draw 45ma. You
must also verify that the voltage available on the mic
connector is in the range of 8 to 15 VDC. Warning: You
can cause permanent damage to your radio by overloading
its Aux Power output!

1) Click on the Windows “Start” Button.
2) Click the Run Button.
3) Click Browse and select the disk drive where the
TM-1 software is located (Floppy or CDROM).
4) Click on the program named SETUP.EXE.
5) Press OPEN.
6) You should now be back at the RUN menu where
you simply click OK to start the installation
process. Follow the directions that appear.
After installation is complete and you are using the program,
you can obtain HELP at any time by placing the cursor in the
field of interest and pressing F1. Access to the entire HELP
database is available from the Help Menu at the top of the
screen. Basic instructions on how to configure the TM-1 can
also be found in the “Configuring The TM-1” section of this
manual.

To power the TM-1 from your radio, you will need to
connect the RJ-11 Radio Interface lines as follows:
Pin “A” (White) - Chassis Ground
Pin “B” (Black) - Accessory Voltage
Pin “F” (Blue) - Signal Ground
To activate the power pin on the Radio Interface you will
also need to install a jumper on “JP-3” of the printed circuit
board. This jumper is located near the Ext Pwr jack on the
board.

- CONNECTING POWER The TM-1 requires an unregulated source of 8 to 15VDC at
approximately 45 milliamps for operation. Power can be
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will need to wire the unterminated end of the cable according
to the documentation supplied with your radio.

Warning: Some RJ-11 cables do not have the wires
arranged in the proper order or may have the connector
installed backwards! Refer to Figure-3 below for the
proper connector and cable layout.

Only five connections are required to attach the TM-1 to a
radio. These connections are PTT (Red), Transmit Audio
(Yellow), Receive Audio (Green), Chassis Ground (White)
and Signal Ground (Blue). If you are powering the TM-1
from your radio, then an additional Power wire (Black) is
also required. Most radios of recent manufacture will have
all of these signals (including Receive Audio) available on
the microphone connector. On radios that don’t have
Receive Audio available on the mic connector, it will be
necessary to run a short jumper cable to the radios External
Speaker jack.

(Rear View)

A (Wht)
Ground

B (Blk)
Power

C (Red)
PTT

D (Grn)
E (Yel)
F (Blu)
RX Audio TX Audio Ground

Figure-3 Radio Connector
Power During Programming – When you attach the TM-1
to your computer for programming, you will need to supply
operating power. The easiest way to do this is by plugging a
DC Wall Transformer into the Ext Pwr jack. Be sure that the
transformer you use supplies a voltage between 8 and 15
volts. Note that some wall transformers put out excessive
voltage when they are operated at lower than the rated
current, so it would be wise to measure the actual voltage
output before plugging it into the TM-1. If a wall
transformer is not available, you can also power the unit
from a 9 volt battery or bench supply.

Exactly how you connect the TM-1 to your radio will depend
on your application. For dedicated telemetry and tracking
applications (no microphone) you can wire the cable directly
to the appropriate pins on the radio’s mic/data connector as
shown in Figure-4.
Radio
RJ-11

A (Wht)
B (Blk)
C (Red)
D (Grn)

Powering A GPS Receiver - The TM-1 can supply power to
a GPS receiver or other device through Pin #9 on the
Data/Control connector. In order to do this the TM-1 must
be powered through the Ext Pwr connector (not the RJ-11)
and the pc-board jumper labeled “JP-1” must be installed.
This jumper is located next to the Ext Pwr jack on the pcb.

E (Yel)
F (Blu)

Gnd (Pwr)
Acc. Voltage
PTT
Speaker Out
Mic Input
Gnd (Mic)

Figure-4 Wiring diagram for data-only applications

In applications where the TM-1 will be connected to a radio
that is being used for both voice and tracking, the TM-1 must
be connected in parallel with the microphone as shown in
Figure-5.

The power available on Pin #9 when JP-1 is installed is
limited to about 250ma by a PTC fuse. On a TM-1 this
power is available any time power is applied to the Ext Pwr
jack. On a TM-1+ the power to Pin #9 is controlled by a
solid-state switch. The switch is turned on any time the TM1+ is ON. This is especially useful for controlling power to
an OEM GPS receiver like the Garmin GPS-35, which has
no manual controls. Using this feature, the GPS is
automatically turned ON and OFF with the TigerTrak. On
both the TM-1 and TM-1+ the power at Pin #9 is
unregulated and is approximately 700mv lower than the
power applied to the Ext Pwr jack. This voltage drop is due
to the polarity protection diode on the jacks input. Before
powering any device from the Data/Control connector, be
sure to verify that the device can be safely powered from the
voltage that you are applying to the Ext Pwr jack! The vast
majority of GPS receivers can be powered from this source.

To TM-1

A (Wht)
B (Blk)
C (Red)

RJ-11

D (Grn)
E (Yel)
F (Blu)

Mic
Radio
Gnd (Mic)
TX Audio
RX Audio
PTT
Power
Gnd (Pwr)
N/A
N/A

- CONNECTING MOBILE & DATA RADIOS -

Figure 5 - Wiring diagram for data/voice applications

The TM-1 attaches to the radio through a 6 wire RJ-11
connector on the rear of the unit. We have supplied a length
of cable for this purpose with your TM-1. The cable already
has the RJ-11 connector installed in accordance with Figure3. If you intend to use a cable other than the one that we
supplied, make sure it is configured exactly as shown in
Figure-3 and read the Warning about these connectors. You

Getting connected in parallel with the mic connector is
generally not as simple as it sounds! The easiest solution is
to make some sort of “Y” cable that splices into the
appropriate lines. Unfortunately, this solution tends to be
both cumbersome and unreliable. A better choice is to
provide a junction box with connectors for all the various
devices and a terminal block to allow selection of the lines
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going to the TM-1. Tigertronics now offers an optional Mic
Adapter Kit for this purpose. The kit includes all the
necessary cables and connectors for both 8-Pin round and 8Pin RJ-45 type mic connectors. Additional details about the
kit are available on our web site. A picture of the Mic
Adapter pc-board is shown in Figure-6.

GPS

TM-1

DB-9F

DB-9M

Transmit Data

3 Receive Data

Ground

5 Ground

Power Input

9 GPS Power

Data Device

TM-1

DB-9F

DB-9M

Transmit Data

3 Receive Data

Ground

5 Ground

Figure-7 Connecting the TM-1 to various devices.

- TEST MODE OPERATION The TigerTrak’s Test Mode has two main functions. First, it
can be used to generate nearly continuous packets for testing
or calibration of deviation. The test message consists of the
station call sign followed by a very long string containing all
printable ASCII characters. Once started, the string is
transmitted continuously until power is turned OFF or PC
MODE is invoked. PC MODE is the mode that the TM-1
uses to communicate with the PC during configuration and
setup. Anytime the TM-1 is running in Test Mode it is also
looking for a PC running the Configuration Program. When
the PC is detected on the Data/Control port, it drops out of
Test Mode and enters PC Mode automatically.

Figure-6 Mic Adapter PC Board

- CONNECTING A HAND-HELD RADIO If you are using the TM-1 with a hand-held radio, you may
find that there is no separate PTT line available. Many of
these radios key the PTT by grounding the microphone input
line through a resistor. If this is the case with your radio,
you can activate the TM-1’s internal PTT keying resistor
(2.7K) by installing jumper “HT” on the pc-board. This
jumper is located near the RJ-11 connector on the rear of the
unit. Note that all radios will work with the keying resistor
value we have provided, including those from manufacturers
that suggest a higher value. If you select the keying resistor
option, be sure you do not attach anything to the PTT (Red)
line on the interface cable. On radios that have a separate
PTT line (ie: Kenwood, etc.) be sure that the “HT” jumper is
not installed. NOTE: Because the antenna on most handheld radios is only a fraction of an inch from where the
cables plug in, we recommend using an external antenna if at
all possible. This will prevent excessive RF levels from
interfering with the operation of the TM-1 and GPS receiver.

To start Test Mode you must simply be pressing the Mode
Switch when you turn on the Power Switch. As soon as the
Power LED lights, you can release the Mode Switch. You
will notice from the PTT light activity that you have started
sending the Test Mode beacons. If you subsequently attach a
computer running the Configuration Program, the TM-1 will
automatically detect it and enter PC Mode. The green
“Lock” light will illuminate to indicate that PC Mode is
active. The only way to exit PC Mode is to turn OFF the
unit.
This happens automatically when you press
Disconnect” from within the Configuration Program or when
you EXIT the program. Never disconnect power to turn
OFF the TM-1 when it is running in PC Mode.

- THE DATA/CONTROL INTERFACE -

- CALIBRATION -

The Data/Control connector on the rear of the TM-1 can be
used to connect a variety of external data sources including
GPS receivers, Programmable Logic Controllers, Weather
Instruments, and Security Systems. The interface can accept
both RS-232 and CMOS logic levels. Input baud rate can be
programmed to 1200, 2400, 4800 or 9600 baud. The data
format is configured for eight data bits, no parity, and one
(or more) stop bits. Figure 7 shows how to connect the TM1 to various types of serial devices.

All critical functions within the TM-1 are controlled by a
precision crystal and will never require calibration.
Normally, the only adjustment that may be required by the
user is the “LEVEL” adjust on the front panel which sets
transmitter deviation. While the level has been factory
adjusted to the correct setting for most radios, there may be
instances where further adjustment is necessary. In such
cases, the level should be set to provide a transmitter
deviation of 3.5 to 4.0 KHz. In most cases, the lower
deviation is better. Note that this is less deviation than
would be appropriate for voice communications. The lower
deviation provides superior phase distortion characteristics
for data transmission and minimizes data errors. To calibrate
the modulation level you will find it helpful to place the TM1 in Test Mode.
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You will need to select an Input Baudrate from this menu
also. This is the baud rate for the data that will be received
by the TM-1’s Data/Control port. For GPS receivers this
baudrate is usually 4800 baud. Baudrates of 1200, 2400,
4800, and 9600 are available to interface to a wide variety of
telemetry and data equipment.

- CONFIGURATION PROGRAM OVERVIEW Getting Connected - To configure the TM-1 for operation
you must attach it to your PC and a power source as
mentioned in earlier sections. Before you start, disconnect
the TM-1 from your radio so that it does not transmit when
you enter Test Mode. Start the Configuration Program on
the PC and then place the TM-1 in Test Mode. This is done
by holding down the Mode button when the Power button is
turned ON. You should see the “Disconnected” button in the
program switch to “Connected” after a few seconds. The
green “Lock” light on the TM-1 will also illuminate to
indicate that it has entered PC Mode and is ready for
programming. The type of unit (TM-1/TM-1+) and current
firmware revision will be displayed at the top of the screen
after connecting.

You will also need to select an Output Baudrate from the
menu. The TM-1 is capable of generating both 300 and
1200 baud packets. The 300 baud selection should generally
be selected for HF operation, while the 1200 baud selection
is normally used for VHF and UHF. Note that there is some
1200 baud packet activity on the 10 meter HF band.
Commercial users will almost always require 1200 baud.
The Help Menu – Selecting the Help Menu provides you
with access to the entire HELP database. It allows you to
Search, Browse, and Print the available information. Note
that you can also get help for a specific field at any time by
placing the cursor in that field and pressing the F1 key.

Reading and Writing - The Configuration Program is
capable of both reading and writing to the data memory of
the TM-1. Once you have established communication and
the program displays “Connected” you can read the TM-1’s
current mode and configuration details by pressing the
“Read” button. After you have changed the configuration,
you can write it back to the TM-1 by pressing the “Write”
button. It is important that you never disconnect power
while the unit is communicating with your PC!

Detailed Mode Settings – Detailed information concerning
the various entry fields within each mode is available from
the online HELP menu. We will make every attempt to keep
expanding the scope of the HELP file and make it available
for download on our web site at: www.gpstracker.com . The
TigerTrak is a very complex product and the user is expected
to have a working knowledge of his application. For
example: We make no attempt to explain the application or
intricacies of APRS®, although the TigerTrak supports this
type of operation. It is the users responsibility to determine
his objectives and the proper protocols for operation. In
some cases a user unfamiliar with a particular application
may need to seek the assistance of a more experienced
associate or even a professional. Our Technical Support is
available to answer questions related to the hardware and
configuration software, but is not available to provide
extensive support for any application, except on a consulting
basis.

If you have connected to the TM-1 just to verify it’s
configuration and do not plan to program (Write) new data,
then you should press the “Disconnect” Button to turn OFF
the TM-1 before disconnecting any cables.
The File Menu – The File menu of the Configuration
Program allows you to manage the various configurations
that you create for the TM-1. The first three selections allow
you to Create, Retrieve, and Save all your configuration data
to a disk file.
The Memorize Defaults button writes the most commonly
used parameters in the program to an initialization file which
loads automatically when the program starts the next time.
After you have created your first configuration you should
click the Memorize Defaults button so that the program will
remember all of your basic defaults like My Call, Serial Port,
Baud Rates, etc.

- MODES OF OPERATION The TM-1+ currently has five different “Modes” of
operation, while the TM-1 is limited to operation in Tracking
Mode only. Note that the TigerTrak can only operate in one
mode at a time! An overview of each mode follows:

The last selections in the File Menu allow you to print a
handy Pocket Guide to help you remember your settings in
NMEA and Tracking Modes. These modes are very
complex and contain may Profile settings. You will find this
feature a valuable tool to manage your unit in the field.

Telemetry Mode - This mode is best suited for applications
in which the data to be transmitted arrives in bursts. As each
data burst is received it is stored in memory for transmission
when the burst is complete. By buffering the data in this
manner, the unit can accommodate data that is arriving at
baud rates both faster and slower than the transmission rate.
The end of the burst is detected by the reception of a
“termination character”. This is a user specified character
that is known to be at the end of the data stream. Typically
this character is a Carriage Return or Line Feed. But it can
be any character that you select between 00 and FF hex. The
only requirement is that the character can never exist
anywhere in the data string except the point at which
transmission should be triggered. The transmit buffer can

The Setup Menu – This menu allows you to select the
various communications parameters for the program. You
must select the Serial Port that the TigerTrak will be
connected to during configuration. There are selections for
COM1 thru COM4. You will need to consult your
computers documentation to determine which port is
available for use. Our factory default is COM2.
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Alarm activation causes a user-defined packet to be sent
identifying the alarm condition. If multiple alarms have
triggered, then multiple messages will be sent. Alarm
packets are sent a specified number of times and at a
programmed interval. After all transmissions are completed,
the TM-1 will reset the alarm status (“image”) based on the
current state of the inputs. If the condition that initiated the
alarm still persists, then the alarm will still be reset using the
current set of conditions ( i.e.: the alarm will not be
triggered again unless the door that was opened later
closes!). The alarm messages are programmed by the user.
The message for Alarm #1 can be up to 25 characters long.
The remaining three messages are limited to 15 characters.

hold as many as 105 characters. If the buffer overflows, data
storage will stop and transmission will be suspended until the
termination character is received. A transmit timer is
provided in this mode so that data can be transmitted at a
user-defined interval. The interval can be set to any value
between 1 second and 68 minutes. Multiple paths are
supported. These paths can be used to route the transmission
through a repeater network or to identify the sending device
with ID Codes.
Beacon Mode – This mode is used in applications where a
fixed message must be transmitted at regular intervals. The
interval can be set to any value between 1 second and 68
minutes. The length of the “Beacon Text” is limited to 76
characters. This mode is ideally suited for transmitting an
APRS® string from a fixed (base) location, so it will appear
on local APRS® maps. It is also useful for transmitting
announcements like severe weather warnings, meetings, etc.

- ABOUT PROFILES Both the NMEA and Tracking modes allow up to ten
separate “Profiles” to be programmed into the TM-1. Each
profile has it’s own SSID, Digi-Path, Transmit Interval, TX
Delay and Tail Delay. The other information used by these
modes (MyCall, ToCall, etc.) is shared among all of the
profiles. Each profile can be selected by the user in the field,
without the need for a computer. This is useful in situations
where the operator is driving from one area to another, and
needs to switch the Digi path from a local path to a more
generic one. It is also a convenient way to change timer
intervals for changing situations, like when you are no longer
moving.

NMEA Mode - This mode was designed primarily for GPS
tracking applications, where entire NMEA sentences need to
be sent. However, this mode can also be used in any
application where the desired data is identified by a known
preamble (header). In operation the incoming data is
searched for a predefined string (Data Header). When the
string is received, the unit starts storing data in its buffer. It
continues to store data until a user specified termination
character is received or until the buffer overflows. The
buffer length is 105 characters. This is sufficiently long to
store any NMEA string. The user can program up to three
Data Headers to search for. A header can be up to six
characters long. The unit searches for and transmits each
header in sequence.
A transmit timer is provided in this
mode so that data can be transmitted at any user-defined
interval between 1 second and 68 minutes. NMEA Mode
allows the user to configure up to ten different “Profiles”,
each with it’s own SSID, Digi Path, Transmit Timer Interval,
TX Delay and Tail Delay.

A profile can be selected by simply pressing the “Mode”
button a number of times that is equal to the profile number
that you want to use. For example, if you want to select
Profile #5 you would press the Mode button five times.
After selecting a profile, the TM-1 will verify your selection
by flashing the “PTT” light a number of times equal to the
profile number selected. The current profile is always saved
to memory when the TM-1 is powered off. Upon power up,
the current profile is loaded from memory and the PTT light
is flashed to indicate the profile number currently selected.
Turning the unit On/Off is a handy way to readout the
current mode. Profiles are one of the most powerful features
of the TigerTrak. They allow you to overcome many
common problems that plague other tracking devices.

Tracking Mode - This mode was designed especially for
tracking applications where shorter packets are desirable.
This mode is flexible in its format and can be configured to
transmit APRS® compatible strings. In operation the serial
input receives $GPRMC NMEA strings from a gps receiver
and parses out the latitude and longitude data needed to
construct the packet.
The user can specify several
parameters that are included in the packet including a
“comment” to be attached to the end of the packet.
Transmission of the packet can be triggered by release of the
microphone’s Push-To-Talk button (mic encoding/manual
mode) or by an automatic transmit timer (auto mode). The
timer interval can be set to any value between 1 second and
68 minutes. This mode allows the user to configure up to ten
different “Profiles”, each with it’s own SSID, Digi Path,
Symbol, Transmit Timer Interval, TX Delay and Tail Delay.

- FIRMWARE UPGRADES Tigertronics may from time to time offer firmware or
hardware upgrades to enhance the features and functions of
the TigerTrak. These upgrades will be announced on our
web site. If you are interested in a particular upgrade, you
should contact our Technical Support Department to
determine the cost and proper return procedures. Generally
upgrades do not involve hardware changes, so they are very
simple and inexpensive.
- TECHNICAL SUPPORT -

Alarm Mode - This mode allows the remote monitoring of
up to four alarm conditions. In this mode the TM-1
continuously compares the state of the alarm inputs to a user
programmed “image”. If the state (High/Low) of any input
deviates from the “image”, then the alarm is activated.

If you read this manual and the Help Files in the
Configuration Program thoroughly, it is unlikely that you
will need additional support. You can also find answers to
many common questions on our Internet web site at:
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without an RMA# clearly marked on the OUTSIDE of the
package WILL NOT BE ACCEPTED. Items being returned
must be sent prepaid. Returned items should have a tag
attached showing the RMA#, customer name, return address,
phone number, and action requested. Units being returned
for warranty repair must be accompanied by a copy of the
original sales invoice showing the date of purchase.

www.gpstracker.com. If you do encounter a problem that
you cannot resolve, you are welcome to call our Technical
Support Hotline at (541) 862-2639. This line is available
each Monday, Wednesday, and Friday between 1:00 PM
and 5:00 PM Pacific Time. Be sure to have your
equipment available for testing when you call. Please DO
NOT mail, email, or fax your technical questions to us. We
realize that calling is a little more expensive, but more can be
accomplished in a few interactive minutes on the phone than
can be accomplished in hours of writing! We simply are not
able to respond to written inquiries involving technical
problems.

Customers wishing to return a product for refund, for ANY
reason, must receive an RMA# within 15 days from the
shipping date shown on the original sales invoice. Customers
returning products for refund will be charged a Restocking
Fee equal to 20% of the purchase price, to cover the cost of
re-testing and re-stocking. Products which have been
damaged or modified in any way, may not be returned.
Contact our Technical Support department for the RMA#.

- VISIT OUR WEB SITES If you have Internet access, please be sure to visit our tracker
web site at: www.gpstracker.com and our main web site at:
www.tigertronics.com These websites contain the latest
news about Tigertronics products as well as a wealth of
information including Software Updates, Application Notes,
Frequently Asked Questions, and other technical issues.

- FCC STATEMENT P/N
S/N

TM-1+
000000

This device complies with Part 15 of the FCC Rules.
Operation is subject to the following two conditions: (1)
this device may not cause harmful interference, and (2) this
device must accept any interference received, including
interference that may cause undesired operation.

- YOUR COMMENTS WELCOME -

NOTE: This equipment has been tested and found to comply
with the limits for a Class B digital device, pursuant to Part
15 of the FCC Rules. These limits are designed to provide
reasonable protection against harmful interference in a
residential installation. This equipment generates, uses and
can radiate radio frequency energy and, if not installed and
used in accordance with the instructions, may cause harmful
interference to radio communications. However, there is no
guarantee that interference will not occur in a particular
installation.
If this equipment does cause harmful
interference to radio or television reception, which can be
determined by turning the equipment off and on, the user is
encouraged to try to correct the interference by one of the
following measures:

Tigertronics has made every effort to make the TigerTrak the
best product possible. We believe it represents a major
technological breakthrough and hope we have anticipated
your every need in using it. We welcome any comments or
suggestions that you would like to make. Please drop us a
note to let us know about your experiences, tips you would
like to share with other users, or how we might do a better
job for you.

- LIMITED WARRANTY Tigertronics warrants the TM-1 to be free of defects in
material and workmanship for a period of 90 days from the
date of shipment. Tigertronics will repair or replace, at its
option, any parts found to be defective during the warranty
period. This warranty does not include any unit which has
been subject to misuse, neglect, improper installation or
operation. This warranty is in lieu of all others, express or
implied, and no person or representative is authorized to
assume for Tigertronics any other liability in connection with
the sale or use of this product. Tigertronics will not be
responsible for any expense or loss of revenue or property
incurred by the user due to operation or malfunction of this
equipment. Tigertronics reserves the right to make circuit or
component changes, or to incorporate new features, at any
time, without obligation.

• Reorient or relocate the receiving antenna.
• Increase the separation between the equipment and
receiver.
• Connect the equipment into an outlet on a circuit different
from that to which the receiver is connected.
• Consult the dealer or an experienced radio/TV technician
for help.
Caution: Changes or modifications not expressly approved
by the party responsible for compliance could void the users
authority to operate the equipment.
To meet FCC
requirements, shielded cables are required to connect this
device to a personal computer or other Class B certified
device.

- RETURN POLICY A Return Material Authorization Number (RMA#) must be
obtained from the factory before any product will be
accepted for return or repair. Items received at the factory
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- TECHNICAL INFORMATION - THE RADIO INTERFACE Pin “F” (Blue) – Signal Ground This is the microphone
ground from the radio. It should be a separate ground from
the power ground.

The radio interface is terminated with standard 6-wire RJ-11
connector. Note that we have identified the various lines
with letters rather than the customary pin numbers to be
consistent with the identifiers used on our Mic Adapter
board. Figure-3 shows both the pin letter designations and
the corresponding wire colors. The signals on this interface
function as follows:

Radio Interface Notes:
1) Keep the lines between the radio and the TM-1 as short
as possible to prevent unwanted noise from entering the
mic circuit.
2) If you are using a radio cable that was not supplied by
Tigertronics, be sure to verify that the connector
orientation is correct using Figure-3. It is extremely
common for the connector to be installed backwards!
3) Be sure that the cable you use has a high quality gold
plated connector that has been installed with a certified
crimping tool. Lesser quality cables, available from
many retail outlets may not provide reliable operation!

Pin “A” (White) – Power Ground This is the ground return
line for TM-1 power. It should be connected to the radios
power or chassis ground pin on the mic connector.
Pin “B” (Black) - Accessory Voltage Input This line can
be used to power the TM-1 from the “Auxiliary Voltage”
available on the mic connector of most radios. The voltage
on this input must be between 8 and 15 VDC.
Approximately 45ma is needed to power the TM-1. See the
“Connecting Power” section of this manual for further
information on the jumpering required and precautions.

Connection Summary:
Pin “A” (White) Pin “B” (Black) Pin “C” (Red)
Pin “D” (Green) Pin “E” (Yellow) Pin “F” (Blue) -

Pin “C” (Red) – PTT
This line is used to “key” the
transmitter. The TM-1 switches this line to ground with a
FET transistor during transmit. The transistor can “sink”
currents as high as 50ma @ 12 volts. When interfacing older
radios that use mechanical switches (relays) in the PTT
circuit, precautions must be taken to insure that voltage and
current limits are not exceeded. If your radio needs some
other kind of keying arrangement (not likely) you will need
to provide it. If your radio is an older model with high
voltage or high current on the PTT line, you will need to
install a small relay to do the keying (very low current 12v
relay). Special provisions have been made to key the PTT of
some “hand-held” radios. See the “Connecting Hand-Held
Radios” section for details.

Power Ground
Accessory Voltage Input
PTT
Rx Audio
Mic Audio
Signal Ground

- THE DATA INTERFACE The data interface to the TM-1 is a standard DB-9S (female)
connector. The signals on this connector function as
follows:
Pin “1” – Alarm Input #1 This alarm input is high
impedance and CMOS level compatible. It is internally
biased to the high (+5v) state and is low-pass filtered to
prevent false triggering. Applying logic levels or simply
grounding this input will activate the alarm.

Pin “D” (Green) - Rx Audio This is the receive audio input
to the TM-1. This line is used to detect channel activity
prior to transmitting. This line is normally connected to
speaker audio and has a nominal input level of 250mv p-p.
This input can be optionally configured to detect a DC level
for use on some data radios. Refer to the “Option Jumpers”
section for further details.

Pin “2” - Transmit Data This line is the serial data output
from the TM-1. It is used exclusively by the computer
during programming of the unit. It should not be connected
for other applications. Output levels are RS-232 compatible.

Pin “E” (Yellow) - Mic Audio This is the transmit audio
output from the TM-1. The output is capacitively coupled
and should be connected to the microphone input of the
radio. The level on this output can be adjusted by the
“LEVEL” control on the front of the TM-1. The level is
adjustable from zero to 80mv p-p (Hi Z). Note that the level
has already been factory adjusted to be compatible with most
radios. You should not attempt to re-adjust the level without
the proper test equipment. Deviation should be set to
3.5KHz for most applications.

Pin “3” - Receive Data This is the serial data input to the
TM-1. Data from a GPS or other telemetry device should be
connected to this pin. The input will accommodate either
standard RS-232 levels (+/- 12v) or CMOS logic levels
(0/+5v). This input is high impedance.
Pin “4” – Alarm Input #4 This alarm input is high
impedance and CMOS level compatible. It is internally
biased to the high (+5v) state and is low-pass filtered to

8

The TM-1 has several jumpers on the pc board for
accommodating special hardware requirements. To activate
the function associated with a particular jumper, you must
short the jumper pins together using a 2mm "Shunt". Several
shunts were supplied with the TM-1 for this purpose. If you
require additional shunts, you can obtain them from most
electronic and computer suppliers, such as Mouser or
DigiKey. Tigertronics DOES NOT supply additional or
replacement shunts! With the exception of JP4, the factory
default for all jumpers is "open". The jumpers are numbered
JP1 through JP5 and function as follows:

prevent false triggering. Applying logic levels or simply
grounding this input will activate the alarm.
Pin “5” – Ground
signal ground.

This pin is used for both power and

Pin “6” – Alarm Input #2 This alarm input is high
impedance and CMOS level compatible. It is internally
biased to the high (+5v) state and is low-pass filtered to
prevent false triggering. Applying logic levels or simply
grounding this input will activate the alarm.

JP1 - WARNING: Be sure to REMOVE JP1 before you
connect the TM-1 to any device that might be damaged by
voltage on DB-9 Pin #9 (computers, etc.)!

Pin “7” – Programming Supply This line is used to supply
negative voltage to the RS-232 driver during programming
of the TM-1 by the computer. It is not connected for any
other application.

This jumper connects power from the External Power jack to
Pin #9 of the DB-9 connector. This jumper can be useful for
powering an external device such as a GPS or telemetry
encoder. Note that in the TM-1+ the power to JP1 is
controlled internally by a solid state switch (Power FET).
This allows the power at Pin #9 to be switched ON
automatically anytime the TM-1+ is turned ON. In the TM-1
the power is not switched and is always applied to Pin #9 if
JP1 is installed. Consequently, any device powered from Pin
#9 on a TM-1 must have its own power switch. In both the
TM-1 and TM-1+ the power to Pin #9 must be limited to
250ma (Max). Any device powered through this jumper
MUST be fused (250ma or less).

Pin “8” – Alarm Input #3 This alarm input is high
impedance and CMOS level compatible. It is internally
biased to the high (+5v) state and is low-pass filtered to
prevent false triggering. Applying logic levels or simply
grounding this input will activate the alarm.
Pin “9” - GPS Power This optional output can be used to
supply power to a telemetry device or GPS receiver. See the
“Connecting Power” and “Option Jumpers” section of this
manual for further information on the jumpering required
and for some important precautions.
Data Interface Notes:

JP2 - This jumper is used to bypass the power switch.
Installing JP2 will cause the TM-1 to begin operating
immediately when the power is applied. This may be useful
in installations where power is controlled by another device.
For example: If the TM-1 is used as a Mobile Tracker,
power could be supplied from the ignition switch so that the
TM-1 is activated anytime the vehicle is in use.

1) Some devices that generate high levels of electrical
noise may not be suitable for connection to GPS Power
line (Pin #9). The noise spikes generated by such
devices may cause ground currents that generate noise in
the transmitted signal.
Connection Summary:
Pin “1”
Pin “2”
Pin “3”
Pin “4”
Pin “5”
Pin “6”
Pin “7”
Pin “8”
Pin “9”

-

JP3 - This jumper connects the input of the TM-1’s internal
voltage regulator to Pin “B” of the RJ-11 connector. This
jumper can be utilized in two different ways. First, it can be
used to allow power from the radio interface (RJ-11) to
power the TM-1. Secondly, because JP3 is at the input of
the TM-1’s power regulator, voltage applied to the External
Power jack will also be supplied to RJ-11 Pin “B” if JP3 is
installed. Note that a diode between JP3 and the External
Power Jack prevents power from RJ-11 Pin “B” from
feeding back to either DB-9 Pin #9 (via JP1) or the External
Power jack. Power supplied to RJ-11 Pin “B” should be
limited to 100ma because of the limited power rating of the
RJ-11 connector itself. Note that power supplied through
JP3 is not switched in either the TM-1 or TM-1+. Refer to
Figure-2 for a better understanding of the power control
circuitry.

Alarm Input #1
Transmit Data
Receive Data
Alarm Input #4
Ground
Alarm Input #2
Program Supply
Alarm Input #3
GPS Power

- OPTION JUMPERS - CAUTION - CAUTION - CAUTION - CAUTION Circuit board jumpers must be used with GREAT
CAUTION.
Incorrect jumper settings can result in
IMPROPER OPERATION or DAMAGE to both the TM-1
and the equipment it is connected to!

JP4 - This jumper determines what kind of signal is
expected on the "Busy" line from the radio (RJ-11 Pin “D”).
The "Busy" line is tested by the TM-1 prior to transmitting.
If the "Busy" line is active, the TM-1 will wait to transmit
until the channel is clear. This avoids collisions with other
signals that might be on the channel. The default setting for
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JP4 is a jumper between pins 2-3. In this configuration the
input (RJ-11 Pin “D”) is terminated with 100 ohms and an
audio level of at least 150mv p-p is expected when the
channel is busy. This is the correct setting for JP4 when
"Busy" is connected to the speaker output of a radio. The
alternate setup for JP4 is to connect pins 1-2. This setting
allows the input to sense a dc level. The dc threshold for
"Busy" will be about 2.5 volts and the input impedance is
increased to 5k ohms. This option allows the "squelch
output" from most “data radio" ports to be used. This is an
important capability since the audio from most "data ports"
is not controlled by the squelch circuit.

- GENERAL SPECIFICATIONS -

JP5 - This is the "HT" jumper. Many handheld (HT) radios
control the PTT function of the external microphone input by
drawing a small amount of dc current through the audio
(mic) input. This is generally accomplished by connecting a
resistor between the mic input and the PTT switch. The
other side of the switch is connected to ground so that a
small current flows through the mic circuit when the PTT is
activated. This current causes the radio to transmit. Jumper
JP5 connects a 2.7k resistor between the PTT circuit of the
TM-1 (RJ-11 Pin “C”) and the mic audio line (RJ-11 Pin
“E”). This resistor value is suitable for all radios. Note that
some handheld radios are NOT switched in this manner (i.e.:
Kenwood, etc.).
Be sure to consult your radios
documentation before installing JP5!
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Levels (Radio):

Mic Audio - 80mv max (Hi-Z)
Receive Audio - 250mv (nom)
PTT - 15v @ 50ma (max)

Levels (Data):

RS232 (+/- 3v min)
CMOS (2.5v min / 5v max)

Power Supply:

+8 – 15 vdc @ 45ma (max)

Operating Mode:

Programmable

Compatibility:

Input: RS-232 / CMOS
Output: AX-25 Packet

Connectors:

Data: DB-9S
Radio: RJ-11 (6)
Power: 2.1mm

Dimensions:

1.1” x 2.7” x 3.0”

Operating Temp:

-30C to +60C

Instructions For Optional Mic Adapter

Assembling The PCB: Assembly and soldering of the Mic
Adapter circuit board is very straightforward. It is a simple
matter of inserting the parts into the board as shown in the
pictures and then carefully soldering all the pins. The only
caution we might make is to be sure that each component is
held tight against the board before you solder. It might be a
good idea to solder just one or two pins and then double
check the positioning of the part before soldering the
remainder. It is extremely difficult to reposition a part after it
is completely soldered, so take your time and double check
your work! Be sure to index the round connector correctly.
Check the connector pin numbers and index notch against
the pin numbers and index printed on the board.

Introduction: The TM-1 Mic Adapter Kit was created to
simplify attaching the TigerTrak to a mobile radio for
tracking applications. The adapter provides a convenient
way to connect to the various mic lines without the need to
cut or splice any existing wiring. The Mic Adapter is simply
inserted in-line between the radio and the microphone.
Inside the adapter there are a series of jumper terminals that
allow you to bridge the appropriate mic lines over to the
TM-1 connector. Although this process is simple in theory,
it is extremely easy to make an error that could have
disastrous consequences! These instructions include a
worksheet to guide you through the process. It is important
that you read this document thoroughly before beginning and
then follow the instructions exactly to insure success. These
instructions will take you through the following steps:
1.
2.
3.
4.
5.

Interface Cable: The next step in assembling the Mic
Adapter Kit is the wiring of the Interface Cable. This is the
cable that connects your radio to the Mic Adapter board.
The reason that we want to wire this first is that it provides a
useful tool for figuring out the microphone wiring in the
steps that follow. We have provided a short length of eight
conductor cable in the kit. The cable already has the RJ-45
connector installed on one end, so you will only need to
install the 8-pin round connector on the other. It is best to
make this cable as short as possible, so trim it’s length
appropriately for the distance that you plan to locate the Mic
Adapter from your radio. In wiring the connector, Pin #8
(center pin) is always the most difficult to solder, so we
would recommend that you wire the connector pins in
sequence starting with Pin #8 (reverse order). Be very
careful not to fray any wires as they can cause pins to short
when the cable is flexed. It would be best to use “heat
shrink” or insulating tubing on the pins, if it is available.
Wire the connector according to the wire colors as shown in
the diagram below.

Assemble the Mic Adapter printed circuit board.
Verify the radio’s microphone connector pin-out
using a multimeter.
Make a table showing the correct pin-out of the
microphone connector.
Complete the jumper wire diagram showing how
to install the jumpers.
Install the appropriate jumpers on the Mic
Adapter circuit board.

WARNING: Incorrect wiring could destroy both the TM-1
and your radio equipment! If after reviewing this document,
you are not absolutely certain that you are technically
qualified to proceed, we recommend that you obtain the
assistance of an experienced technician.
Tigertronics
assumes no responsibility for the use or misuse of this
adapter. This document is intended only to provide basic
guidelines to a qualified technician.
It is the sole
responsibility of the user to insure proper wiring.
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are wired in parallel (Pin #1 = Pin #1), you can use the pins
on the back of the boards round connector for testing. These
pins are much easier to probe than an RJ-45 pin and are very
clearly numbered on the pc board. Turn the radio OFF and
attach the Mic Adapter board to your radio using the
Interface Cable.

Mic Connector: The next step is to determine for certain
the function of each pin on the mic connector. If your radio
has a round 8-pin connector the process is very straight
forward, but if your radio uses a RJ-45 (telephone like)
connector, the process can be a little tricky! To wire either
connector you must have the Users Manual for your radio
available for reference.

Start the identification process by checking for continuity
between the radios chassis and the connector pin number that
is listed as Chassis Ground in your radio manual. For
example: If the manual says that Pin #3 is Ground, then
check continuity between the radio chassis and the third pin
(Pin #3) on the round connector. When making this
measurement, remember that you are looking for “Zero
Ohms”. There will no doubt be some amount of continuity
between several other pins, but remember that the one you
are testing for is a “short” to ground! If you don’t find
continuity on the pin that you tested, then the pin numbers
must be reversed in the radio manual. You can verify this by
testing the third pin from the other end (in our example Pin
#6). You should find continuity on that pin if the order is in
fact reversed.

To minimize the possibility of making a wiring mistake, we
have provided a wiring table for you to complete in the
Jumper Wire Diagram. As the correct signal is determined
for each microphone pin, you should record it in the table.
You might want to use a pencil for this process, in case you
need to make a change or use the table for a different radio
later.
If your radio uses the 8-pin round connector, you should be
able to copy the signal names and their associated pin
numbers directly from the radio manual into the appropriate
lines of the Jumper Wire Diagram. When copying this
information, be sure that you refer to the actual pin numbers
given. Do not attempt to determine the pin number from any
illustration of the connector. When you are finished, it
would be a good idea to double check the accuracy of your
information by testing continuity between chassis ground and
the pin that is supposed to be Ground on the connector.

If you would like to up your confidence even further, you
can turn your radio ON and test the PTT line. Your radio
should be attached to an antenna or dummy load for this test,
since you will be transmitting briefly. In this test you will be
manually keying the transmitter by briefly shorting the PTT
line to Ground. If one is available, use a small value resistor
(a few hundred ohms) to short the PTT line to Chassis
Ground (chassis - not the ground pin). The resistor is not
really necessary, but a good idea just in case you are shorting
the wrong pin! If the radio transmits, you can be absolutely
certain that you have the pin numbering correct.

If your radio uses an RJ-45 mic connector, you cannot
assume that the pin numbers in the manual are listed
correctly. If the manufacturer has not followed the industry
standard numbering conventions, the lines will be in the
correct sequence, but in reverse order (Pin #1 = Pin #8)!
Unfortunately this is not at all uncommon. On a number of
occasions we have even found disagreement in the
numbering system between radio models from the same
manufacturer! You should never assume the position of Pin
#1 on any RJ type connector, based on the diagram in the
manual. Since these lines often times have Accessory
Voltage on them, wiring the connector incorrectly can have
catastrophic results!

Once you have established whether or not the pins in the
manual are listed in reverse order, you should enter the
signal names into the appropriate lines of the Jumper Wire
Diagram. If the lines were not reversed, then you can enter
the signals exactly as they are numbered in your radio
manual. If the connector numbers were reversed, then enter
the signals into Jumper Wire Diagram in the reverse order.

The best way to insure you have the correct wiring order is
to verify with a multimeter where the Ground and PTT pins
actually are on the connector. Because the RJ-45 pins are
dangerously close together and very fragile, we will use the
Interface Cable and Mic Adapter board to help make these
tests. Since the adapters RJ-45 and 8-pin round connectors
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Mic Adapter RJ-11

Mic Adapter RJ-45 / 8-Pin Rnd

Ground (Pwr)

A

1 ____________________________

Acc. Voltage

B

2 ____________________________

PTT

C

3 ____________________________

RX Audio

D

4 ____________________________

TX Audio

E

5 ____________________________

Ground (Mic)

F

6 ____________________________
7 ____________________________

Speaker Input

8 ____________________________

SQ

Jumper Wire Diagram

About the only solution to that problem is to use an external
speaker or modify the radios Aux Spkr jack so that it does
not cut the internal speaker off. NOTE: Pin “B” (Acc.
Voltage) going to the TM-1 is not required and should not be
connected under normal circumstances. Refer to the TM-1
Installation Manual for details about this pin.

This means that the signal listed in the radio manual as Pin
#8 should be entered into the Jumper Wire Diagram next to
Pin #1. The signal listed in the manual as Pin #7 should be
entered into the Jumper Wire Diagram as Pin #2 and so on,
until all entries are complete.
Jumper Wire Diagram: Now that you have completed the
entries in the Jumper Wire Diagram, you are ready to draw
in the Jumpers that need to be installed on the Mic Adapter
pc board. This is simply a matter of matching the TM-1
signals in the left column with the corresponding radio
signals in the right column and then drawing a line between
them representing the jumper that you need to install. You
may find that some of the signal names taken from the radio
manual are not as descriptive as you might like, but generally
the manual will also contain a brief description of each line
that will help you understand the function well enough to
make the match.

Installing Jumpers: Using short lengths of the hookup wire
provided with the adapter kit, install jumpers on the pc board
according to the diagram that you created above. These
wires should be installed on the top side of the pc board, so
that the jumpers can be checked or changed at a later date
without removing the board from the enclosure.
Packaging the Mic Adapter: Tigertronics currently does
not supply a housing for the Mic Adapter board. It is up to
the ingenuity of the user to find an appropriate package
suitable for his purpose. For those who would like to
package the board in a small plastic case, we would suggest
looking at the Radio Shack case #270-1801. We have found
this case to work very well for “under dash” installations. To
use this case, you will need to drill down or cut off the four
standoffs on the floor to provide clearance for the pc board.
You will of course also need to make the necessary holes and
cutouts in the case for the Mic Adapter. The pc board
should be mounted to the floor of the case using two #4
screws and short standoffs.

On occasion you may find a radio that does not provide a
separate Mic Ground and Chassis (Pwr) Ground. In this case
you can simply jumper TM-1 pins “A” and “F” together and
then connect them to the single radio ground. The TM-1
uses speaker audio (Pin “D”) to determine if the channel is
busy before it transmits. If your radio does not provide
speaker audio on the mic connector, you can deal with the
problem in several ways. First, if you are technically
inclined, you could run the radios speaker audio to an unused
(or unnecessary) pin on the mic connector. This is a nice
solution but sometimes rather difficult to accomplish. The
second solution is to run speaker audio from the radios Aux
Spkr jack to the 3.5mm miniature phone jack on the Mic
Adapter board. This jack is connected to the terminal point
on the board marked “SQ”. The “SQ” terminal can then be
jumpered to the RX Audio pin to the TM-1 (Pin “D”). The
drawback to this solution is that plugging into the Aux Spkr
jack of most radios will disable the radios internal speaker.
If you are also using the radio for voice communications, this
is a problem.

TigerTrak™ is a trademark of Tigertronics, Inc.
APRS® is a trademark of Bob Bruninga
TM-1 Manual v1.2
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